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Introduction

Background

The Beypazari Granitoid is a crystallized magma chamber emplaced in a Late Cretaceous
volcanic arc in north central Turkey (Billur 2004). This pluton is of specific interest because it
records collisional processes during the closure of the NeoTethys Ocean (Sengor et al. 1981), a
major event in Earth history. The granitoid pluton crops out in the Sakarya Zone, a lithospheric
sliver that trends from east to west for approximately 1500 km and extends 200 km from north to
south (Okay and Tuysuz 1999).

During the summer of 2011, my supervisor (Dr. Elizabeth Catlos), graduate mentor
(Karen Black), and Okan Yildiz (a Turkish undergraduate student from Middle East Technical
University) collected samples of the Beypazari Granitoid. Zircons from these granites were
dated in rock thin-section using an ion microprobe. The ages range from Late Cretaceous to
Early Eocene (102.8+16.8 Ma to 48.9+2.7 Ma). This represents a significant age range within a
single pluton, and may be related to pulses of magma within the chamber. In addition, two ~6
Ma zircons were dated in one of the samples, a considerably younger and unexpected result.
These zircons are located within a cross-cutting aplite dike. They are not likely related to
emplacement of the pluton, and may represent metamorphic ages related to a change in tectonic

regime associated with the activation of the North Anatolian Fault.

The Problem

The purpose of my Undergraduate Honors Thesis project is to explore the problem of the
origin of the ~6 Ma zircons. Resolving this issue will provide an opportunity to develop ideas
about the nature and influence of strike-slip deformation. The Beypazari Granitoid can not only
provide useful insights into the tectonic processes of collision that consolidated the Turkish
Anatolian Plate, but also constrain the tectonic influence of the North Anatolian Fault. This
strike-slip fault system presents a major seismic hazard in Turkey as the Anatolian Plate migrates
to the west relative to the Eurasia Plate. The M7.4 Izmit Earthquake of 1999, for example,
resulted in the deaths of tens of thousands of people and rendered millions homeless (Ucarkus et
al. 2011).



My central hypothesis is that the ~6 Ma zircons represent metamorphic ages related to
motion along the North Anatolian Fault, and the range of Late Cretaceous ages relates to pulses
of magmatism during crystallization of the Beypazari Granitoid pluton. The long-term goal of
this research is to improve our basic comprehension of the tectonics of north central Turkey, with
a focus on the Beypazari granite. This will lead to a better understanding of the influence of

extension, extrusion tectonics and strike-slip faulting in the region.

This Report

This report describes the development of a series of ArcGIS maps generated for my use
in the field. The final three maps include: 1) a Geologic Map of the Beypazari Granitoid, 2) an
Outcrop map with sample locations, towns and roads, and 3) a HillShade Map with outcrops of
the Beypazari Granitoid to aid in finding and confirming faults or other structures in the field. 1
also calculated the outcrop area of the granitoid and the length of roads that coincide with the

outcrop to get a better idea of accessibility to the pluton.

Data Collection

Existing Data
Dr. Mark Helper provided a wealth of ArcGIS data collected from a variety of sources
such as the USGS. These data include shapefiles of cities, rivers and roads, and an outline of

Turkey.

ASTER DEM

ASTER (Advanced Spaceborne Thermal Emission and Reflection Radiometer) is an
Earth-orbiting remote sensing device that generates high-resolution digital elevation data of the
Earth’s surface. An ASTER DEM (digital elevation model) can be obtained free of charge on
the USGS Land Processes Distributed Active Archive Center (LP DAAC) website. | ordered a
DEM of my field area in geographic coordinate system WGS1984 using the following

procedure:

e Visit the LP DAAC website at https://Ipdaac.usgs.gov/get_data (Figure 1).
e Obtain the required username and password to order the free DEM.

e Click on Launch Reverb.
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Figure 1. To download ASTER DEM, visit LPDAAC website and click on Launch Reverb.

e Enter the geographic coordinates (lat/lon) bounding the area of interest (Figure 2).

The order takes a few days to process, and a link to an ftp site is provided via email to retrieve
the DEM in TIFF format.
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F'igure 2. Click drop-down Bounding Box and enter the geographic coordinates bounding the area of interest.



ArcMap Data Generation
In order to develop my field maps, | needed not only to import the data provided by Dr. Helper

and LP DAAC, but also create new data in ArcGIS. Below is my process:

e Starting with a blank ArcMap document, click the File drop-down menu and click the
Map Document Properties and check the Pathnames box near the bottom to Store
Relative Pathnames to Data Sources. This is a helpful initial step ensures that the
software can find the appropriate files for the map regardless of which computer is used
(Figure 3).

Map Document Properties ?

General |
File: G:\327-GIS\Project\Beypazari_Pluton_Map_10.mxd
Title:

Summary:

Description:

Author:
Credits:
Taags:

Hyperlink base:

Last Saved: 5/1/2012 12:04:46 PM
Last Printed:
Last Exported:  4/28/2012 1:12:42PM

Default
Geodatabase: G:\327-GIS\Project\New_My_Data\Beypazari_Siv

Pathnames: (V] Store relative pathnames to data sources

Thumbna: [ MekeThumbnai | | Delete Thumbns

o) o) i)

Figure 3. Store relative pathnames to enable the map to find data from any computer. (File=>Map Document Properties)




o Create a project folder (Project) and a subfolder (My_Data) to serve as the central storage
folder for the geodatabase, shapefiles, and other data specific to the map.

Extract and Import TIFFs
When the ASTER DEM data arrived, | needed to extract the zipped files in Windows
Explorer and import them into an ArcGIS map.

e In Windows Explorer, create a subfolder (Extracted_zips) under the Project folder for
downloading zipped ASTER DEM files.

¢ Right-click and select Extract All to unzip these files into the same folder for later
processing (Figure 4). ASTER files are conveniently named with the latitude and

longitude of the bottom-left corner of the square image.
e From ArcCatalog, drag and drop each DEM.tif into the TOC.
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Figure 4. Extract TIFF files in Windows Explorer.



Mosaic DEM

The spatial reference of the DEM was GCS_WGS_1984, and it did not need to be
projected. It is very important to maintain the spatial reference that comes pre-defined in a
dataset because it is the known spatial reference against which all other data are referenced.

e From ArcCatalog, browse to the Extracted_Zips subfolder.

e Drag and drop each *dem.tif file into the map (Figure 5).
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Figure 5. Drag and drop the DEM image(s) into the map from the central storage folder in ArcCatalog.
The DEM was in four square rasters with differing minimum and maximum elevations.
To combine them into a seamless image, | converted them to a new single raster using the

Mosaic function in the ArcGIS toolbox (Figure 6):
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Input Rasters — | Spatial Reference for
| =l Raster (optional)
<> ASTGTM2 N3SED31.dem.tf [E Specifies the map
A *ASTGTM2_N39E032_dem. if projection of the output
< » ASTGTM2Z_MN40E031_dem.tif raster mosaic.
< ASTGTM2_M40ED32_dem. tif
Output Location
G:\327-GIS\Project\New_My_Data\Beypazari_Sivrihisar. mdb
Raster Dataset Mame with Extension
mosaic
Spatial Reference for Raster (optional) B
GCS_WGS_1984
Pixel Type (optional)
16_BIT_SIGNED -
Cellsize {optional)
[ oK ] [ Cancel ] [Environments... ] l << Hide Help ] l Tool Help ]

Figure 6. Create a single raster file from the DEM(s). (Data Management->Raster->Raster Dataset-=>Mosaic to New
Raster)

e Open ArcToolbox from within ArcMap. (NOTE: For ease of use, always click first on
Tool Help at the bottom of all toolbox screens.).

e Click on Data Management Tools, Raster, and Raster Dataset.

e Double-click Mosaic to New Raster.

e From the Input line drop-down, select the four rasters.

e Inthe Output line, designate the destination of the new raster by clicking the file icon and
browsing to the central storage folder.

e Name the new mosaic raster, set the pixel size, pixel depth and cell size to match to
original raster files. Number of bands should be 1.

e Click OK. A single raster image of the combined DEM raster is generated and added to
the map.

e Right-click the four original ASTER rasters in the TOC and click Remove. They are no

longer needed on the map.
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Create Hill[Shade
A HillShade raster generates a shaded relief image that assumes an infinite illumination
source like the Sun. | generated a HillShade from the new single mosaic raster, which | will use

in the field to identify and locate potential faults and other structures at the surface (Figure 7).

., Hillshade = &8 % |
Input raster Output raster
|nm_mosaic ﬂ

| Output raster The output hillshade raster.

G:\327-GISProject\New_My_Data\Beypazari_Sivrihisar.mdbhillshade
| Azimuth (aptional) The hillshade raster has an
315 integer value range of 0 to

Altitude {optional) 285.

45
[] Model shadows {optional)
&2 factor (optional)
1
[ oK l [ Cancel ] [Envimnments... l [ << Hide Help l [ Tool Help

Figure 7. Generate Hillshade raster. (Spatial Analyst->Surface->Hillshade)

e In ArcToolbox, click on Spatial Analyst, and Surface.

e Double-click on Hillshade.

e Inthe input line, select the mosaic DEM file.

e In the output, designate the central storage folder and name the hillshade raster.

e Click OK. The HillShade is added to the map.



Create Elevation Contours
Contours are lines of equal elevation on a map. | added contours for every 100 meters on

12

my Geologic Map to help me see elevation differences on the pluton and surrounding area

o B R

(Figure 8).
gontour
- -
Input raster Contour interval
|new_r'r'|nsaic ﬂ
Output polyline features Interval of contours.
G:\327-GIS\Project\New_My_Data\Beypazari_Sivrihisar. mdb\contour
Contour interval This can be any positive
200 number.
Base contour {optional)
[¥]
Z factor {optional)
1
’ [8]4 ] ’ Cancel l [Erwironments... ] ’ << Hide Help ] Tool Help

Figure 8. Generate Elevation Contours. (Spatial AnalystéSurfaceéCBnmr)

e In ArcToolbox, click on Spatial Analyst and Surface.

e Double-click Contour.

e Select the mosaic DEM raster as the input. The output is the central storage folder.

e Name the output shapefile (Contour) and designate the contour interval (100).

e Click OK. The contour is generated and added to the map.
e Right-click on the shapefile in the TOC and click Properties then the Symbolize tab to

select the appropriate line colors and weights to be drawn on the map.

e To select specific elevations from among the complete list of 100-m contours in the

Symbology tab, click Add Values.
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Scan Geologic Maps

To generate a geologic map of the Beypazari Granitoid, | scanned the Zonguldak and
Ankara sections from the Geological Map of Turkey in the Walter Geology Library. | imported
the scanned maps into Adobe Photoshop and combined them, aligning the lines of latitude and
longitude. | saved the Photoshop image as a TIFF image so it could be imported into ArcGIS
(Figure 9).

File Edit View Bookmarks Insert Selection Geoprocessing Customnize Windows Help ArcPad Data Manager ~ | .';:9 - ,. | = Georeferencing~ | L
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Figure 9. Scan paper maps, align in Adobe Photoshop, save as TIFF. Drag and drop into ArcMap TOC.

e From ArcCatalog, drag and drop the image.tif file into the top of TOC. The imported
TIFF is lacking a spatial reference.

¢ In ArcCatalog, right-click the image.tif again and click Properties.

e Click Edit beside Spatial Reference and Import to select the reference frame of the
mosaic raster (Figure 10).

e Click OK. This will set the appropriate Spatial Reference of the image.tif. (NOTE:
Select Yes for a dialogue box asking to build a Pyramid).
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Raster Dataset Prope;liesi ‘_ | ? : = Spatial Ref ] Pmpih’ = 4 Jlm
General XY Coordinate System
Property Value -~ MName: Unknown
Colorn'.lap absent . . . Details:
Pyramids level: 4, resampling: Nearest Neighbor Build. ..
Compression Mone i
E  Extent
Top 42, 2083871978
Left 30.7981945242
Right 33.1992530909 AN
Bottom 36.7247315217
=] Spatial Reference <Undefined > Edit...
Linear Unit
Angular Unit
= Statistics Options +||= ~
= Band_i Statistics have not been calculated.
Build Parameters Select a predefined coordinate system.
Min Import a coordinate system and X/, Z and M
Max L domains from an existing geodataset {e.g.,
Mean feature dataset, feature dlass, raster).
Std dev. e Create a new coordinate system.
| Modify... | Edit ﬂ'_'le properties of the currently selected
[ oK ] [ G ] [ oply ] " | ooordinate system.
- . '.—.= —~ o, o oowmoer | | Clear | Sets the coordinate system to Unknown,
W 4 - il . F )
' Look in: ’E New_My_Data v] 2 @ @ | . | e | B O & | Save As... | gﬁ:e the coordinate system to a
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contours.shp
IMajor_Cities_clip.shp
ew_hillshad2
ew_hillshade

# new_mosaic
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[*=JPluton_clip.shp
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| Show of type: [Geoga;ﬁcdamsets v]

Figure 10. For a raster file lacking a spatial reference, set it to match the mosaic of known spatial reference.

)

(ArcCatalog=>Properties=>Edit (Spatial Reference)=> Import=>browse to select mosaic raster)



15

Georeference Scanned Image to Mosaic DEM
Using the known lines of latitude and longitude from the scanned image.tif, |
georeferenced the image to the corners of the DEM (Figure 11).
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Figure 11. Georeference by clicking the same corner of each m p seaunta.

To georeference, | used the following procedure:

e On the Georeferencing Toolbar drop-down menu, select the scanned image.tif.

e Click View Link Table, then Add Control Points.

e The first point to click is the top left intersection of latitude and longitude on the image.tif
that will correspond to the same intersection on the mosaic.

e Next, right-click on the mosaic raster in the TOC and click Zoom to Layer. Click the
same intersection to connect that point to the image.tif. Do the same for the bottom left
intersection, and bottom right intersections of both image and raster.
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e Important: The final top right intersection should be double-clicked to complete the links.

e Inthe Links table, four sets of data are listed. If exact coordinates are known, in the X-
Map and Y-map columns, manually change the inputs to the known values of latitude (Y-
Map) and longitude(X-Map). Save this table to the central storage folder (Figure 12).

e Click Save and name the file for storage in the central storage folder.

e Now the scanned image lies directly on top of the single DEM and can be used for
digitizing. Right-click on the scanned image and select Display to change the

transparency to 50% so that digitized lines will be easier to see.

”j georef_links - Motepad =RiC 2
File Edit Format View Help

8.256284 33.483795 31. 000000 41. 000000 »
21.4908486 33.588492 32. 000000 41. 000000

21.835392 16.031876 33. 000000 39. 000000

8.239152 15. 883398 31. 000000 39. 000000

F ;

Figure 12. In the Georeferencing Links Table, edit to add exact lat/lon values in Xx-map and y-map. Save to central
storage folder.

Create Personal Geodatabase
In ArcGis, a personal geodatabase is used to organize and store data such as point, lines

and polygons for use in the map.

e In ArcCatalog, right-click on the central storage folder and click New and Personal

Geodatabase, and name the geodatabase appropriately.
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Create Feature Dataset

The Feature Dataset holds all Feature Classes (Point, Line and Polygon shapefiles) used
in the map and attaches fields in each shapefile with the appropriate data stored in the
geodatabase (Figure 13).

e Right-click on the new geodatabase.

e Hover over New and click on Feature Dataset.

e Name the new Dataset (mine was named Geology).

e Click Next and select the appropriate Coordinate System.

e There is an option to select a vertical coordinate system, but I did not specify one.
e Click Next, to set the appropriate XY tolerance (often the defaults are OK).

e Click Finish to create the New Feature Dataset.

MNew Feature Dataset v =R

Choose the coordinate system that will be used for XY coordinates in this data.

Geographic coordinate systems use latitude and longitude coordinates on a spherical model
of the earth's surface. Projected coordinate systems use a mathematical conversion to
transform latitude and longitude coordinates to a two-dimensional linear system.

Mame: WGES 1984

EI South America i —
[ Sphercid-based
I E-E3 warld
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") TTRF 1989 Modify...
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= ITRF 1991
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i ITRF 1994
o ITRF 1996
= ITRF 1997
o ITRF 2000
= ITRF 2005
i NSWC 97-2
L WIGS 1906
i WGS 1972
3 WIGES 1972 TBE
WGES 1984
[+ Projected Coordinate Systems -

1

m

[ < Back ][ MNext = ][ Cancel ]

Figure 13. Create Feature Dataset. (Right-click geodatabase->New->Feature Dataset)



Develop Data Dictionary
Before | digitized the rock units based on the complex scanned Zonguldak and Ankara
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maps, | created a Data Dictionary (Figure 14) using MS Excel. The data dictionary includes the

rock units and names, unit abbreviations, and ages found in the legend of the scanned maps. |

used the information in the spreadsheet for creating domains to attribute points, lines and

polygons.
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12 Ankara CenozcTertiary tertiary Eocene low_eocene Continental ep
13 Ank_Z Cenozc Quaternary quaternary Continental, Undifferentiated Q
14 |\Ank_Z Cenozc Tertiary tertiary Continental, Undifferentiated n
15 Zonguldal Cenozc Tertiary tertiary Miocene miocene Continental, Undifferentiated mk
16 Zonguldak Diorite, gabbro, diabase 8
17 Zonguldak Mesozc Jurassic jurassic DOGGER-MALM jdm
18 Ankara CenozcTertiary tertiary Eocene eocene Flysch ef
19 Zonguldal Mesozc Cretaceous cretaceous Flysh krf
20 |Ank_Z Mesozc Cretaceous cretaceous Upper upper Flysh kruf
21 Zonguldak Gneiss, micaschist, amphibolite G
22 Ank_Z Granite, granodiorite, quartz-diorite
23 Ankara CenozcTertiary tertiary Oligocene_Mic olige_miocene Gypsiferous Facies olmj
24 Zonguldal Mesozc Jurassic jurassic LIAS jl
25 Zonguldak Mesozc Jurassic jurassic MALM jm
26 Ank_Z Marble, crystalline limestone, dolomii Mr
27 Ank_Z Paleczoic Metamorphic Per

Figure 14. Develop a Data Dictionary to help organize information in the geodatabase domains.

Enter Data into Geodatabase Domains

Using information from the data dictionary, | populated the fields of my geodatabase

domains (Figure 15).

e Right-click on the geodatabase and select Properties and click Domains.
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o Enter appropriate information, such as Rock type, Unit Name, and Unit Abbreviation, in
the Domain Name and Description to identify the types of features that will be attributed
during the digitizing process.

e For each Domain Name, a Field Type and Domain Type can be specified. | used Text
Field Types and Coded Value Domain Types. Under Coded Value, | entered the

information from my Data Dictionary.

¢ When the Database Properties have been created, click OK.

Database Properties

7

2z

Generzl | Domains

Domain Properties:

Domain Mame Description -
Downside Fault Downside |:
Epoch Geologic Epoch
Era Geologic Era
Exposure Exposure
Fault_Type Fault Type
Period Geologic Pericd
Points Point Features
Reoad_name Road Mame

W rock Tune | oock o _panara I

Field Type Text &
Domain Type Coded Values W |
Spiit policy Default Value il
Merge policy Default Value

Coded Values:

Code Description -
Acid_intrusiv Acid_intrusiv |_|
Andesit_spili Andesit_spili
Baszalt_doleri Baszalt_doleri
Basic_intrusi Basic_intrusi
Coal_bearing Coal_bearing
Comoreh serie Comoreh serie s

[

OK || Canesl

Apply

Figure 15. Create Domgﬁs in the geodatabase to add drop-down definitions for Feature Class attributes. (Right-click

geodatabase—>Properties=>Domains)
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Create Feature Classes

Feature Classes used in digitizing can contain points, lines, or polygons that are added to

the map.

e Right-click on the Feature Dataset (Geology).

e Hover over New and select Feature Class (Figure 16).

e Name the Feature Class (Contacts, for example) and select the Type (point, line, or
polygon) appropriate for what will be digitized. 1 digitized lines and later converted them
to polygons.

e Click Next and click on Field Name to name the type of feature to be digitized.

e Click the Data Type drop-down menu and select the type of information to be attributed.

e Under Field Properties below, click the Domain drop-down menu to attach coded values
of the same name as those stored in the domain of the geodatabase.

e Define the permitted length of characters in Field Properties.

New Feature Class ? P

Name: Contact
Alias:

Type

Type of features stored in this feature class:
Line Features -

Geometry Properties

[7] Coordinates include M values. Used to store route data.

[7] Coordinates include Z values. Used to store 30 data.

< Back [ Meat = I I Cancel

Figure 16. Create New Feature Classes. (ArcCatalog>Right-click Feature Dataset>New-> Feature Class)
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Digitize features

To digitize my geologic map, | first digitized my Contact Line Feature Class creating a

box around the borders of my DEM for use in snapping rock unit contact lines using the

following procedure:

In the TOC, make sure the feature class to be digitized is selected (check box).

Click List by Selection above the TOC and make sure the desired feature class is enabled
(disable all others).

Turn on the Snapping Toolbar and select Vertex.

On the Editing Toolbar, drop-down select Start Editing and select the appropriate layer to
digitize.

Under Create Features, select the line tool and begin digitizing. The first click is in the
top left, the next click is the bottom left, then the bottom right, the top right, and finally
double-click snap back to the top left.

On the Editing Toolbar drop-down, click Save and Stop Editing and the Save the map
with the Save icon on the Standard Toolbar.

Turn on the Snapping Toolbar and select End and Edge in addition to Vertex.

After digitizing the outline, digitize other relevant lines following the visible (but 50%
transparent) lines of the existing scanned map image, and snapping to ensure each line
segment is connected to another (Figure 17). This is an important step for lines that will

be converted into polygons.
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Eigure 17. Set scanned map to50%transparentand digitize Contacts. "

e Inthe TOC, right-click on the Feature Class and select Symbolize to choose the line color
and weight for each type of feature that will appear on the map and in the Legend during
map final formatting.

e Point feature classes (such as Towns and Sample Locations) are created, digitized, and
symbolized using the above procedure.

e Save edits frequently, both in the Editing Toolbar and the map in general!

Create a Topology

In ArcGIS, topology rules define how points, lines and polygons share geometry. The
rules are set by the user to prohibit, for example, lines from self-intersecting or dangling. Areas
not completely enclosed by snapped lines cannot be converted into polygons. To ensure that all
Contact lines were properly snapped during editing, | created a Topology as follows:

e Right-click on the Feature DataSet.

e Hover over New and select Topology (Figure 18).
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Mew

Topology

Enter a name for your topology:
geology_Topology

Enter a duster tolerance:
0.0000000089831528411952133 Decimal Degrees

The duster tolerance is a distance range in which all vertices and boundaries
are considered identical, or coincident. Vertices and endpoints falling within the
duster tolerance are snapped together.

The default value is based on the XY tolerance of the feature dataset. You
cannot set the duster tolerance smaller than the XY tolerance.

[ < Back “ Mext = ][ Cancel ]

Figure 18. Create a Topology to define rules for points, lines and polygons. (Feature Dataset=>New->Topology)

Click Next on the Topology Wizard and name the topology. (The Cluster Tolerance
default value often does not need to be changed.)

Click the boxes beside the Feature Classes that will be included in the Topology. In my
Topology, | had only a single Feature (Contacts), so it was ranked 1. Otherwise, select a
rank for each feature to determine how much it moves during validation of the topology.
Click Next. Click Add Rule and drop-down select the Feature Class and Rules, such as
Must Not Overlap, Must Not Self-Intersect, and Must Not Have Dangles (Figure 19).
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Mew Topology | ¥ % % Rt
Py
Spedfy the rules for the topology: m
Feature Class Rule Feature Class [ Add Rule ]
Contacts Must Mot Overlap ?
Contacts Must Mot Have Da... Remove
Contacts Must Mot Self-Inte...
[ Remaove All ] é
[ Load Rules,.. ] Z/
.y [ Save Rules. .. ] -
—
-
=
< Back ][ Mext = ] [ Cancel ]
\?"\"{_‘—\-\.L o
dd Rule 7R

Features of feature dass;

Rule Description

IC:::ntar:ts

Rule:

| Must Not Self-Intersect

Feature class;

S a0

Show Errors

A line feature from one layer must
not intersect itself.

Any line where the feature
overlaps itself or any point where
the feature intersects itself is an
Errar.

[ K ][ Cancel ]

Figure 19. Topology Rules ensure that lines do not overlap or self-intersect. (Feature Dataset=>New-=>Topology)

e Click Next and then Finish to generate the new Topology.

e Click Yes in answer to the dialogue box Would you like to validate now? (Every time

topology errors are corrected, re-validate.)

¢ Right-click on the newly created Topology located under the Feature Dataset in

ArcCatalog.
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e Click Properties, then click Errors and Generate Summary. A table will list the errors by

category (Figure 20).

Topology Properties ? 2
| General | Feature Classes | Rules | Ermors |

Generste Summary [ Export To File... ]
Rule Errors Exceptions
Must Be Larger Than Cluster Tolerance a 0
Must Mot Cverlap

Contacts a 0
Must Mot Have Dangles

Contacts 40 0
Must Mot Self-Intersect

Contacts 3 0
Total 43 0

[ QK ] [ Cancel ] Apphy

Figure 20. The Topology Error Summary identifies problems for correction.

e Right-click on the Topology again, and click on Item Description and Preview. Answer
No to the dialogue box Do you also want to add all feature classes that participate in the
Topology? This just adds digitized lines, but only the errors are important. A screen
with pink error squares will appear showing any violations of the Topology rules (any
dangles or self-intersects).

e From ArcCatalog, drag and drop the Topology into the top of the TOC.

e From the Editor toolbar, drop-down select the Feature class to be corrected. This
activates the Topology toolbar.

e Inthe Topology toolbar, click on Error Inspector and click Search Now to view and zoom

to each error (Figure 21).
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BOBIE -5
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[=] Contacts_good
= O Ankara_Zonguldak.tif
RGE
[ Red: Band 1
[1Green: Band_2
I Elue: Band_3
= O new_hs_mask
Value
High : 254

Low: 0

= O contours_Clip

[ Constructi

[@e| 2 « +

Error Inspector

Show: <Errors from all rules> | zemors [¥]Errors [7] Exceptions [7] Visible Extent orly

Rule Type Class1 Class 2 Shape Featurel Feature 2 Exception
Must Mot Have Dangles Contacts_good Point 1 1]

False

Must Mot Have Dangles Contacts_good Point 1 a False

Figure 21. Correct Topology errors before converting lines to polygons.



e After zooming into the error, right-click the Data Frame in the TOC and set the Reference
Scale. This will make the error visible.

e Use the editing tools to correct Dangles by adding or snapping to vertices together.
Correct Self-Intersects by deleting or moving vertices, as appropriate.

e When all vertices are properly snapped, run the Topology rules again (as above), clicking

on Errors to Generate Summary until all pink squares are gone (Figure 22).

|
Topology Properties ? | EE
|Gene.-|al | Featurs Classes | Rules | Errors |

Generate Summary [ Export To File... ]
Rule Errors Exceptions
Must Be Larger Than Cluster Telerance a 0
Must Mot Overlap

Pluton_lin_cl ] ]
Must Mot Have Dangles

Pluton_lin_cl 0 0
Must Mot Self-Intersect

Pluton_lin_cl 0 0
Total 0 0

| ok || Ccancel Apply

Figure22. The Topology Error Summary confirms all errors were corrected.
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Convert Line Feature to Polygon
To create fully enclosed rock units that could be symbolized with colors and attributed
with rock unit names and unit abbreviations, | converted my Line Feature (Contacts) to Polygon

(Rock Units), as follows:

e In ArcToolbox, click on Data Management, Features, and Feature to Polygon (Figure 23).
e The input is the Line Feature Class to be converted.
e Save the Output Feature Class to the central storage folder with appropriate name.

e Click OK. The new Polygon Feature Class is added to the map. The Line Feature Class

can now be removed from the map.

Table Of Contents ax

B

&3 #, Feature To Folygon =B8] =

Input Features “ | Output Feature
Class

clogy_Topslogy2
Area Errors

4]

CENEI]E N

< Contacts_good

Line Errors The output polygon feature

class.
Point Errors

= Contacts_good

= [0 Ankara_Zonguldak.tif

Output Feature Class
G:\327-GIS Project i

X¥ Tolerance {optional)

My _Data) _Sivririsar.mdb\gealegy Rock _unit
Decimal degrees -

Preserve attributes {optional)
Label Features (optional)

Low:0

_ [ o ][ concel |[envronments..][ <<tderep | [ Toolhep |

Figure23. Convert Line Feature Class to Polygon Feature Class. (Data Management - Feature->Feature to Polygon)
e Open an editing session for a Polygon Feature Class, right-click on a polygon and select

Attribute to choose from domains in the geodatabase that are attached to the Polygon

Feature Class. Attribute all polygons (Figure 24).
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Figure 24. Attribute all polygons in an editing session to assign values from the drop-down connected to geodatabase domains.
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e Point (Towns) and Line (Roads) Feature Classes are also attributed in editing sessions. |
attributed my Road Line Feature Class as shown in Figure 25.

Table Of Contents 7 x
8o8 =
= & layers

= M roads clip

[m]

2 O Ankarz_Zonguldak.tif

Figure25. Attribute all points and lines similar to the process for attributing polygons.
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¢ Inthe TOC, right-click on the Polygon Feature Class and select Properties and Symbolize
to choose the appropriate symbology, colors and line weights for points, lines, and
polygons (Figure 26).

Layer Properties

7| K

|Genem| I Source ISeIection I Displa:.f| Symbology | Fields I Definition Queryl Labels I Joins & Felates I Time I HTML F'opupl

S:‘;:m |Dra'll categories using unique values of one field. Import...
Categories Value Field Color Ramp
Unique values Rock_type - -
- Unique values, mary
. Match to symbaols in a
Quantities Symbol  Value Label Count *
Charts :l <all other values: <all ather values: -
Multiple Attributes <Heading> Rock_type 1
Acid_intrusiv Acid_intrusiv 7
Andesit_spil Andesit_spil 7 1+
Basalt_doler Basalt_doler 7
4 n 3 Basic_intrusi Basic_intrusi 7 *
Beypazan Beypazan 7
Coal_bearing Coal_bearing 7
Compreh_serie Compreh_serie 7
Cont_undiffer Cont_undifer 7 -
Add Al Values ] [ Add Values... Remove Remove Al ] l Advanced -

[

0K

J [ coneel ||

Apply

)

Figure 26. Symbolize Polygon Feature Class. (TOC->right-click Feature Class=>Symbology)
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e While in Layer Properties, click Display and change Transparency to 50% so the texture

of the Hillshade will be visible from beneath.

Clip Layers to the Map Outline
I realized while digitizing that | needed a more manageable map area so | created a new
smaller map outline shapefile (Pluton Outline), and clipped the existing feature classes to clean

up the layers, including rock units, contours, rivers, and towns.

e In ArcToolbox, click on Analysis Tools, Extract, and double-click Clip (Figure 27).
e The Input is the Feature Class to be clipped and the Clip Feature is the Pluton Outline.

e Save the Output Feature Class in the central storage folder with appropriate name.

Table Of Contents nx

EEECEE

= = Layers
= contours_Clip

o . T S - = @ =

Input Features

- |Simp|e_ur|it5 ﬂ
= roads_clip Clip Features
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M Beypazari ’Decimal degrees v]
I Metamaerphic .
I Ophiolitic
Sedimentary ’ CK ] [ Cancel ] ’Enuironments... ] [ Show Help == ]
Yoleanic |

= M Pluton_outlin ! . P “," w;ﬁ
O S 3 S

Figure 27. Clip Feature Classes to the Map Outline. (Analyst>Extract>Clip)

Mask Raster Image
To trim my Hillshade raster to the appropriate size, | masked the raster to the smaller new

Pluton Outline.

e In ArcToolbox, click Spatial Analyst Tools, Extraction, and double-click on Extraction
by Mask (Figure 28).
e The Input Raster is the raster to be masked. The Feature Mask is the Pluton Outline. The

Output Raster is the location and name of the new masked raster.
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Figure28. Raster images can be Masked to trim them to the desired size (Spatial Analyst=>Extraction>Extract by Mask)

Add GPS Sample Locations
When rock samples were collected in the field, GPS latitude and longitude for each

sample location were saved to an MS Excel spreadsheet. | added those points to the map, as

follows:

e Open MS Excel and save the spreadsheet as a .csv (comma-delimited text).

e In ArcMap File drop-down menu, hover over Add Data and select Add XY Data. (Figure

29).
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'Figure29. Add data from .csv (comma delimited) file. (File menu>Add Data>Add XY Data>browse to .csv file)
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e Click the Folder icon to choose a table by browsing to the central storage folder and click

Add. The .csv file is added as an Event. A dialog box appears, as shown in Figure 30.
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Table Does Mot Have Object-1D Field | 2

The table you specified does not have an Object-1D field so you will not be able to
select, query, or edit the features in the resulting layer, or define relates for them.

After you create this layer, you can export it to a shapefile or feature class if you
need these functions, To export a layer, right-click it in the Table Of Contents and
choose Data= Export Data, Add the exported data to the map as a new layer,

oK ] [ Cancel

Figure30. Dialog box with instructions for converting the .csv file to a shape file.

e To convert the .csv Event to a Shapefile for use in the map, right-click on the .csv in the
TOC, click Data and Export Data, saving the file to the central storage folder with
appropriate name (Figure 31).
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Figure 31. Convert the .csv file to shapefile that can be Selected, Queried and Edited.

e Symbolize the imported GPS points appropriately for inclusion in the map.
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Digitize Additional Points of Interest

When | go to the field, | want to collect additional rock samples for inclusion in my
study. To help me find my way to potential outcrops in the field, I edited the Point Feature Class
(see Digitizing above) to add towns and promising sample collection sites along roads

throughout the pluton, as shown in Figure 32.

Table Of Contents o x
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Figure 32. Digitize points (Towns) with the same procedure as Polygons.

Export Feature Class to New Feature Class

I wanted to make another map with the HillShade overlain only by the Beypazari
Granitoid rock units for use in analysis and identification of possible faults. The ~6 Ma zircons
found in the area may be related to fault motion. To make a copy of the digitized Polygon

Feature Class (Simple Units), I used the following procedure:

e In ArcCatalog, right-click on the Polygon Feature Class (Simple Units), hover over

Export and select To shapefile (single) (Figure 33).
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i:igure 33. To make a copy of a Feature Class, Export it to a new Feature Class.

e The Input is the layer to be converted. The output location is the central storage folder,

and the Output Feature Class is the name.

In this newly created Polygon Feature Class (Beypazari), | edited to delete all polygons
except the Beypazari Granitoid and set transparency to 50% (Figure 34).
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Figure 34. Edit Polygon Feature Set to delete all but the desired polygons.
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I also exported the Point Feature Class that included all towns into new a Feature Class

(Towns) and changed the symbology to deselect all but the towns of Beypazari and Omaagac. |

did the same for the GPS data (Sample Locations), symbolizing each sample name (Figure 35).
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Figure 35. Symbolize po ft. ' ght-click Properties= Symbology—=>Add VaILE)
Add a Second Data Frame

I wanted to include a reference frame in my printed maps that shows where in Turkey the

field area is located.

e From the Standard drop-down menu at the top, click Insert, then Data Frame.

e From ArcCatalog, drag and drop the shapefile of the outline of Turkey into the second
Data Frame.

e Export the Town shapefile to a new shapefile (Town2) and delete all towns except
Beypazari.

e Drag and drop new Town2 shapefile into the second Data Frame.

Label Features
To ensure that labels would print at the appropriate font size, | set the Reference Scale to
1:250,000.

¢ Right-click Layer in the TOC, hover over Reference Scale and select Set Reference

Scale.



Using the Label Manager Toolbar, | formatted the font size and halo for labels of contours,

towns, roads, and sample locations (Figure 36).
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Figure 36. Use the Label Manager Toolbar to designate the size, orientation, and location of labels.

e Inthe TOC, right-click on each Feature Class and click Label Features, as appropriate for

a given map.

ArcGIS Calculations

Area of Beypazari Granitoid Outcrops

With my ArcMap feature elements completed, | was ready to answer the question: What

is the footprint of the Beypazari Granitoid outcrop? However, my map is in WGS1984 (decimal

degrees) and | want to calculate in square kilometers, so | temporarily projected the reference

frame into the UTM36N coordinate system. | calculated an area of ~232 km? with the following

procedure.

e Right-click on Layer Properties and click Coordinate System then change the Spatial

Reference to WGS_1984 UTM_Zone_36N. Click OK.
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e Right-click on the Feature Class (Beypazari) and open the Attribute Table.

e Inthe Table Options drop-down menu, select Add Field. Name it Area and give it Type
Double. Click OK.

¢ Right-click on Area and select Calculate Geometry, using the coordinates of the data
frame (UTM) and Units of square kilometers.

e Right-click Area column again and select Statistics for the sum of all shape areas in the
Feature Class (Figure 37).

Table
ERAL AL
Beypazari
OBJECTID = Shape * Rock_type Unit_abbrev Unit_name Period Era Epoch | Shape_Length | Shape_ Area | Area
2 | Polygon Acid_intrusiv BG Beypazari Cretacecus | Mesozoic | Late 0.116728 0.000538 [ 5.1181
3 | Polygon Acid_intrusiv BG Beypazari Cretacecus | Mesozoic | Late 010527 0.000305 | 2.8952
9 | Polygon Acid_intrusiv BG Beypazari Cretaceous | Mesozoic | Late 0.092724 0.000386 | 3.6632
17 | Polygon Acid_intrusiv BG Beypazari Cretacecus | Mesozoic | Late 1.019555 0.013024 [ 12381
18 | Polygon Acid_intrusiv BG Beypazari Cretacecus | Mesozoic | Late 0.077883 0.000373 | 3.5319
20 | Polygon Acid_intrusiv BG Beypazari Cretaceous | Mesozoic | Late 0.128888 0.00068 | 6.4488
21 | Polygon Acid_intrusiv BG Beypazari Cretaceous | Mesozoic | Late 0.171688 0.001282 | 12.144
22 | Polygon Acid_intrusiv BG Beypazari Cretacecus | Mesozoic | Late 017645 0.000885 | 8.3789
23 | Polygon Acid_intrusiv BG Beypazari Cretacecus | Mesozoic | Late 0.07222% 0.000278 | 26353
25 | Polygon Acid_intrusiv BG Beypazari Cretaceous | Mesozoic | Late 0.475281 0.006712 | 63.538
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Figure 37. Calculate Areas from a Feature Class Attribute File using Calculate Geometry.

Length of Roads On Outcrops

When looking for rock samples in the field area, | want to know how much of the pluton
outcrops are accessible by road. While the Layer was still projected (temporarily) into UTM
coordinates I clipped the Roads Feature Class to the Beypazari Feature Class. | calculated a road
length of ~81 km.

e Right-click on the Line Feature Class (Roads) and open the Attribute Table.
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¢ Inthe Table Options drop-down menu, select Add Field. Name it Length and give it Type
Double. Click OK.

¢ Right-click on Area and select Calculate Geometry, using the coordinates of the data
frame (UTM) and Units of kilometers.

e Right-click Area column again and select Statistics for the sum of all shape areas in the
Feature Class (Figure 38).

e Once calculations are complete, reset the reference frame to WGS_1984 under Layer

Properties.
Table
bey_rd_clip
OBJECTID = SHAPE = Road name SHAPE_Length Length
1 | Polyline =Mull= 0.00442 0.388031
2 | Polyline Bey_Kirb_yolu 0.131635 12.126541
3 | Polyline Bey_Kirb_yolu 0.013595 1.489534
4 | Polyline =Mull= 0.050757 4431602
5 | Polyline =Mull= 0.013453 1422218
& | Polyline =Mull= 0.025064 2609029
7 | Polyline <Mull= 0.007415 0.721103
& | Polyline Bey_Kirb_yolu 002291 2280414
9 | Polyline =Mull= 0.027874 2432484
10 | Polyline =Mull= 0. 101087 5.539762
11 | Polyline =Mul= 0.077126 T7.609156
12 | Polyline <Mull= 0.064433 5783325
4 4 o » w E {0 out of 20 Selected)
bey_rd_clip
P =
Statistics of bey_rd_clip | P
Field
lengh Frequency Distribution
Statistics:
Count: 20 6
Minimum: 0.358031 5
Mapdmum: 12.1.26541 4
Sum: 81.420953
Mean: 4.071048 3
Standard Deviation: 3.391842 3 I
] L
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100
P b
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Figure 38. Calculate the length of roads with access to the pluton using Calculate Geometry.
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Map Formatting

Map 1 —Geologic Map of the Beypazari Granitoid, north central Turkey

The geologic map is useful for understanding what rock units are found in the area, and
their geometric relationships to my field area. The Feature Classes in this map include Simple
Units, Contours, Hillshade, and the Towns of Beypazari and Omaagac. The Outline of Turkey
Data Frame with a star by the town of Beypazari is provided for reference. By clicking Layout
View at the bottom of the screen, I inserted the title, two scale bars, scale text, a north arrow,
contour interval and the coordinate system. | added a legend of rock types associated with colors
on the map. Finally, | added a Grid to overlay the map with lines of latitude and longitude.

Map 2 — Outcrop Map, with Sample Locations and Potential Locations

The outcrop map will be my field guide as I search for new outcrops for sample
collection. The Feature Classes in this map include the Beypazari Rock Unit, Sample Locations,
Potential Sample Locations, Roads, Rivers, Towns, and the Turkey Outline with a star to identify
Beypazari. A title, scale bars, scale text, north arrow, coordinate system, legend, contour interval

and Grid overlay were added.

Map 3 — Hill[Shade Map with Beypazari Granitoid and Inferred Fault

The hillshade map can help to analyze patterns, such as faults and other structures. In
fact, I was able to infer a possible fault near the town of Beypazari, which I will confirm in the
field. The Feature Classes include the Beypazari Rock Unit, Hillshade Raster, Inferred Fault,
and Turkey Outline. A title, scale bars, scale text, north arrow, coordinate system, legend, and

Grid overlay were added.

I exported all maps to PDF file type using the main drop-down File menu and selecting Export

Map to browse to my central storage folder.
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Outcrop Map of the Beypazari Granitoid, north central Turkey,
with Sample Locations and Potential Locations
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